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Chapter 1: Introduction

About  th is  Gu ide
You are going to learn about the following topics:

• Your first steps with ActivClient

• Smart cards

• Digital certificates

• Remote Access and one-time passwords

• ActivClient usage and management

• Personal Information

• ActivClient and Terminal Services

Aud ience
• Network or system administrators

• IT support staff

• End users

Assumed knowledge  and  pre requ is i tes
This document assumes the audience has a good computer knowledge and 
some understanding of Public Key Infrastructure.

O ther  documents
This Guide is part of ActivClient set of documents including:

• ActivClient CAC User Guide (this document)

• ActivClient CAC Installation Guide

• ActivClient CAC Overview

• ActivClient CAC Quick Start



Chapter 2: Getting started
In this section, you will learn about the following topics:

• "Your first steps with ActivClient" on page 10.

• "Working with the User Console" on page 12.

Your  f i rs t  s teps  wi th  Act ivC l ient
Depending on your organization, you may need to configure your smart card 
before you can use it for authentication or digital signature operations.

Your first steps with ActivClient are determined by your:

• Smart card status (whether your administrator has prepared the card for 
you and it is ready to use, or not).

• ActivClient configuration (defined during ActivClient setup).
ActivClient CAC User Guide 10
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Your first steps with ActivClient
Here is a list of actions to be taken according to your smart card status:

Table 2-1: Getting started according to your smart card status

Smart card status Action

If you have a blank 
smart card (no PIN).

Your administrator has given you a blank smart card. You need to 
initialize the card before you can use it.

1. Log on to your workstation using the same user name and 
password that you used before installing ActivClient.

2. Initialize your new smart card and create your PIN. For more 
information, see "Initializing a smart card with the PIN 
Initialization Tool" on page 15".

3. Load credentials on your smart card as described in "Managing 
Digital Certificates" on page 27".

4. Use your card to log on to your workstation (if your administrator 
instructs you to do so), to sign email, to access secure Web sites, 
etc.

5. At any time, you may access the ActivClient User Console to 
configure ActivClient, your smart card, or your credentials. For 
more information, see "Working with the User Console" on 
page 12.

If your smart card is 
personalized with a 
PIN but is not 
configured for 
Windows PKI logon.

Your administrator has given you a smart card and a PIN, and the 
smart card has already been personalized with your credentials (for 
example, with digital certificates - but not configured for Windows 
logon). Your card is ready to use.

1. Log on to your workstation using the same user name and 
password you used before installing ActivClient.

2. Use your card to sign email, to access secure Web sites, etc.
3. At any time, you may access the ActivClient User Console to 

configure ActivClient, your smart card, or your credentials. For 
more information, see "Working with the User Console" on 
page 12.

If your smart card is 
personalized with a 
PIN and a Windows 
PKI logon digital 
certificate.

Your administrator has given you a smart card and a PIN, and the 
smart card has already been personalized with your credentials 
(including a digital certificate configured for Windows logon). Your 
card is ready to use.

1. Log on to your workstation using your smart card and your PIN. 
For more information, see "Logging on to Windows with a 
certificate" on page 54".

2. Use your card to sign email, to access secure Web sites, etc.
3. At any time, you may access the ActivClient User Console to 

configure ActivClient, your smart card, or your credentials. For 
more information, see "Working with the User Console" on 
page 12.
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Working with the User Console
Work ing wi th  the  User  Console

What  can  you  do  w i th  the  User  Conso le ?
Here is a summary of the tasks you can do from ActivClient User Console:

You can Action

Manage your digital certificates • Import a CA digital certificate, see 
"Managing user and CA 
certificates" on page 29.

• Import a User digital certificate, see 
"Managing user and CA 
certificates" on page 29.

• Export a digital certificate, see 
"Managing user and CA 
certificates" on page 29.

• View a digital certificate, see 
"Managing user and CA 
certificates" on page 29.

• Delete a digital certificate, see 
"Deleting a certificate" on page 33.

• Set as default, see "To select a 
certificate for Windows PKI login" 
on page 35.

• Make your certificates available to 
Windows, see "To make certificates 
available to Windows" on page 38.

Manage your one-time passwords • Generate a one-time password, see 
"Getting a one-time password 
automatically" on page 74.

• Re-synchronize a one-time 
password, see "Synchronizing 
smart cards" on page 39.

• Configure a user name for one-
time password-based remote 
access, see "Configuring a remote 
access user name" on page 40.

View your personal information Available for the US Department of 
Defense on Common Access Cards 
(CAC) or US Government Personal 
Identity Verification (PIV) cards only. 
See "About Personal Information" on 
page 77.
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CHAPTER  2 :  GETT ING  STARTED
Working with the User Console
To access  the  User  Conso le
• From the ActivClient Agent icon located on the workstation’s taskbar:

Double-click ActivClient Agent  .

The ActivClient User Console is displayed.

-Or-

Right-click ActivClient Agent  and select Open.

The ActivClient User Console is displayed.

• From the Start menu:

Go to Programs, ActivIdentity, ActivClient, and select User Console.
The ActivClient User Console is displayed.

Manage your smart card • Change a PIN, "Changing a smart 
card PIN" on page 19.

• View your smart card information, 
"Viewing smart card information" 
on page 25.

• Unlock your smart card, "Unlocking 
a smart card PIN" on page 21.

• Initialize your new smart card, 
"Initializing a smart card with the 
PIN Initialization Tool" on page 15.

• Reset your smart card, "Resetting a 
smart card" on page 18.

• View your unlock code, "Viewing 
your unlock code" on page 21.

• Select a smart card reader, from 
the Reader List icon on the 
Standard toolbar.

Run ActivClient Tools to:

• Troubleshoot
• Diagnose
• Configure advanced settings

• Run the Troubleshooting wizard. 
"Troubleshooting ActivClient" on 
page 44.

• Run the Advanced Diagnostics 
Tool. "Performing advanced 
diagnostics" on page 46.

• Go to the Advanced Configuration 
Manager window. "Troubleshooting 
ActivClient" on page 44.

You can Action
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CHAPTER  2 :  GETT ING  STARTED
Working with the User Console
For more information on the ActivClient User Console, you can refer to 
ActivClient CAC Overview.
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Chapter 3: Managing smart 
cards

This section discusses the following topics:

• "Initializing a smart card with the PIN Initialization Tool" on page 15.

• "Resetting a smart card" on page 18.

• "Changing a smart card PIN" on page 19.

• "Unlocking a smart card PIN" on page 21.

• "Viewing smart card information" on page 25.

In i t ia l iz ing  a  smart  card  wi th  the  P IN 
In i t ia l iza t ion  Tool

To initialize your smart card you need to access the PIN Initialization Tool.
The PIN Initialization Tool allows you to:

• Initialize your smart card by setting a PIN code.

• Reset a PIN code while erasing the content of the smart card.

But first, you need to check if your smart card belongs to the two types of 
supported smart cards.

Suppor ted  smar t  ca rds
Blank and standalone smart cards are the two types of smart cards supported 
by the PIN Initialization Tool.

B lank  smar t  cards
Blank smart cards are smart cards with no applets uploaded. Once initialized 
by the PIN Initialization Tool, those smart cards are ready to use. No PIN 
unlock mechanism is available. If the PIN code is locked due to too many 
wrong PIN entries or if the PIN code is forgotten, the smart card can be run 
through the PIN Initialization Tool again and you will be able to choose a new 
PIN code, but the previous content of the smart card will be completely 
erased. 
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CHAPTER  3 :  MANAGING SMART  CARDS
Initializing a smart card with the PIN Initialization Tool
Standa lone  smar t  cards
Standalone smart cards are smart cards with preloaded applets. Those type of 
smart cards have an identifier such as S1, S4, O4 or S5 engraved on the lower 
right of their back. At the end of PIN Initialization, an unlock code is 
displayed. Write it down in a secure place. An unlock code or a PIN code will 
be needed later if you want to re-initialize those smart cards and erase their 
content.

For the list of blank smart cards (ActivClient Standalone / Mini configuration) 
and standalone smart cards (ActivClient Standalone configuration), refer to 
chapter 4 of ActivClient CAC Overview.

Important: Trying repeatedly to initialize a smart card that is not in a supported 
configuration can make the smart card permanently unusable.

To  access  the  P IN  In i t i a l i za t ion  Too l
You can access the PIN Initialization from different locations, depending if you 
have installed or not the User Console and ActivClient Agent.

• From ActivClient Agent icon located on the workstation’s taskbar:

Right-click ActivClient Agent icon  and select PIN Initialization Tool.
The PIN Initialization Tool wizard is displayed.

-Or-

• From ActivClient User Console:

1. Insert your smart card.

2. Go to the Tools menu and select New Card.
The PIN Initialization Tool wizard is displayed.

-Or-

• From the Start menu:

Go to Programs, ActivIdentity, ActivClient and select PIN Initialization Tool.
The PIN Initialization Tool wizard is displayed.
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CHAPTER  3 :  MANAGING SMART  CARDS
Initializing a smart card with the PIN Initialization Tool
To in i t i a l i ze  your  smar t  ca rd  us ing  the  
P IN  In i t i a l i za t ion  Too l

Use the following procedure to initialize your PIN using the PIN Initialization 
Tool.

1. Start the PIN Initialization Tool. To learn how, see "To access the PIN 
Initialization Tool" on page 16.

2. Follow the PIN Initialization wizard.

3. Enter your new PIN code, confirm it, and click Next.

Note: Enter a PIN that is easy for you to remember, but difficult for others to guess! 
The PIN code must conform with the PIN rules displayed by the tool. All the 
rules must display a green check for the PIN Initialization Tool to let you move 
forward.

4. In the case of an already initialized standalone smart card (with an unlock 
code), you must enter a PIN or unlock code.
When the initialization is complete, the Finish window is displayed. 
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CHAPTER  3 :  MANAGING SMART  CARDS
Resetting a smart card
5. In the case where an unlock code is displayed, write it down in a secure 
location and click Finish to close the window. 

Note: If the smart card is already initialized, the PIN Initialization Tool will reformat 
the card: all content present on the card (including private keys) will be 
permanently deleted.

Reset t ing  a  smart  card
Resetting a smart card removes most of the information stored on your smart 
card, including your digital certificates, your PIN code and any ActivIdentity 
AAA or SecureLogin SSO information. It only preserves the smart card pre-
loaded applets.
In order to reset the smart card, you need to know either the smart card’s PIN 
or the unlock code.

To  rese t  your  smar t  ca rd
1. Open ActivClient User console.

2. Insert your smart card (chip side up and chip first) into the smart card 
reader.

3. Click Reset Card from the Tools menu. 

4. When a confirmation message is displayed, click Yes.
The Reset Smart Card dialog box is displayed.
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Changing a smart card PIN
Note: The “Reset” and “Re-initialization” procedures can also be done using the PIN 
Initialization tool.

Changing a  smart  card  P IN
Changing you smart card PIN should be done regularly to ensure that you are 
the only person accessing your smart card.

To  access  the  P IN  Change  Too l
You can access the PIN Change tool by taking either one of the following 
actions:

If... Action

You know the smart card PIN. Make sure the PIN is selected, type 
your PIN in the box, and click OK.

You do not know the smart card 
PIN and the smart card was 
initialized with ActivClient in 
standalone mode.

1. Select Unlock Code.
2. Type the unlock code that you 

saved after initialization, and 
click OK.

For more information, see "Viewing 
your unlock code" on page 21.

You do not know the smart card 
PIN, and the smart card was 
initialized by your administrator.

1. Select Unlock Code. 
2. Call your IT administrator. You 

may be asked to give the 
challenge Code displayed in the 
Challenge Code box. 

3. In the Unlock Code box, type 
the unlock code that the 
administrator gave you, and 
click OK.
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CHAPTER  3 :  MANAGING SMART  CARDS
Changing a smart card PIN
• From ActivClient Agent icon’s right-click menu:

Select PIN Change Tool.
The PIN Change tool wizard is displayed.

• From ActivClient User Console:

Select Change PIN from the Tools menu.
The PIN Change tool wizard is displayed.

-Or-

Select Change PIN from the Standard toolbar.
The PIN Change tool wizard is displayed.

• From the Start menu:

Go to Programs, ActivIdentity, ActivClient, and select PIN Change Tool.
The PIN Change tool wizard is displayed.

All conditions (green marks) must be filled and green checked before you can 
proceed to the Next step.

WARNING: Attempting to enter too many wrong PIN’s will lock your smart card! Make 
sure you view your unlock code and write it down in a secure place before you 
lock your smart card inadvertently.
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Unlocking a smart card PIN
Unlock ing a  smart  card  P IN
If you enter too many consecutive wrong PINs when trying to use your smart 
card, your card is automatically locked. You must then unlock it before you 
can use your smart card.
Make sure you know your unlock code! An unlock code helps you unlock your 
smart card whenever it is locked. 
Unlocking your smart card is necessary to access all of the information stored 
on it.

V i ew ing  your  un lock  code
You are probably in one of the three following cases:

• If you initialized your smart card directly with ActivClient in standalone 
mode, you are also responsible for the unlock code. You need to view your 
unlock code in order to save it in a secure location. This unlock code helps 
you unlock the smart card if you lock it by entering multiple incorrect 
PINs.

• If you received an already initialized smart card, your administrator is 
responsible for your unlock code.

• If your smart card was initialized with ActivClient in a Standalone / Mini 
mode (see "Supported smart cards" on page 15), the smart card cannot be 
unlocked. However, you can re-initialize your smart card with the PIN 
Initialization Tool.

To  v iew your  un lock  code
Prerequisites

• ActivClient User Console is open.

• Your smart card has been initialized with ActivClient in standalone mode.

1. Select View Unlock Code from the Tools menu.
The Display Smart Card Unlock Code dialog box is displayed.

2. Enter your PIN code when prompted.

3. Write down your unlock code and save it in a secure location. You need 
this unlock code in case you lock your smart card in the future.
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Unlocking a smart card PIN
Important: If you check the Never display the Unlock Code again check box, the Display 
Smart Card Unlock Code dialog box will never display again. Consequently, 
your Unlock Code will never display again!

Un lock ing  your  smar t  ca rd  P IN
The information displayed in the Unlock your smart card dialog box is based 
on your configuration.

To  un lock  a  smar t  card  in i t i a l ized  by  
the  admin is t ra tor
When ActivClient detects that a smart card initialized by the administrator is 
locked, the Unlock Smart Card PIN dialog box is displayed. You can then 
retrieve a Challenge code.
ActivClient CAC User Guide  22



CHAPTER  3 :  MANAGING SMART  CARDS
Unlocking a smart card PIN
1. Call your IT administrator and give the challenge code displayed in the 
Challenge Code box.

2. In the Unlock Code box, type the unlock code that the administrator gives 
you.

3. In the New PIN box, type the new PIN.

4. In the Verify box, retype the new PIN, and click OK.
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Unlocking a smart card PIN
To un lock  a  smar t  card  in i t i a l ized  w i th  
Act i vC l ient
When ActivClient detects that a smart card initialized with ActivClient is 
locked, the Unlock Smart Card PIN dialog box asking for your Unlock Code 
and a New PIN is displayed. 

1. Retrieve the unlock code that you saved when you initialized your smart 
card.

2. In the Unlock Code box, type the unlock code that you retrieved.

3. In the New PIN box, type the new PIN.

4. In the Verify box, retype the new PIN, and click OK.

Note: ActivClient can be configured so that the unlock screen is displayed as soon 
as a locked smart card is inserted in the system.
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Viewing smart card information
To access  the  Un lock  Smart  Card  P IN  
d ia log  box
• From ActivClient User Console:

Select Unlock Card from the Tools menu.
The Unlock Smart Card dialog box is displayed. 

• Insert a locked smart card into your smart card reader.
The Unlock Smart Card dialog box is displayed. 

V iewing smart  card  in format ion
ActivClient User Console provides you with technical information about your 
smart card such as: 

• User name

• Smart card manufacturer name (when known)

• Smart card type (when known)

• Serial number

Smart card information is set by default and cannot be modified.

To  access  the  Smar t  Card  In fo  w indow
You can use different ways to access smart card information from ActivClient 
User Console:

• From the User Console tasks pane:

1. Insert your smart card.

2. Click on Smart Card Info.
The Smart Card Info window is displayed on the right pane.

-Or-

• From the User Console right pane:

1. Insert your smart card.

2. Double-click the Smart Card Info icon.
The Smart Card Info window is displayed on the right pane.
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Viewing smart card information
-Or-

• From the User Console right pane:

1. Insert your smart card.

2. Right-click the Smart Card Info icon.

3. Select View smart card info.
The Smart Card Info window is displayed on the right pane.

Note: Your user name is supplied by ActivClient from either one of the following 
items:

• Your remote access (AAA) user name (if present on smart card)

• Windows login user name of your default certificate which is determined 
by your smart card settings.
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Chapter 4: Managing Digital 
Certificates

This section discusses the following topics:

• "Downloading a certificate with Microsoft Internet Explorer" on page 27.

• "Downloading a certificate with Firefox" on page 28.

• "Managing user and CA certificates" on page 29.

• "Selecting certificates for Windows PKI login" on page 35.

• "Making certificates available to Windows" on page 37.

Note: Some of the operations described in this chapter (such as importing/deleting 
a certificate from your smart card) are only possible if the policy of your smart 
card permits it.

Downloading a  cer t i f i ca te  w i th  
Microsof t  In ternet  Exp lorer

You can use a PKI key pair (unique to you, generated directly on your smart 
card) and an associated digital certificate (proving your identity inside your 
organization) in order to use a variety of security services.

To  download  a  ce r t i f i ca te  w i th  
Mic rosof t  In te rne t  Exp lore r

Prerequisites

• Microsoft CAPI support option has been installed during setup.

• Your administrator provided you with a Web site URL to access your 
organization's Certificate Authority. To download a smart card logon 
certificate, your organization's Certificate Authority must be either one of 
the following:

– Windows 2000 Certificate Authority
– Windows 2003 Certificate Authority
– A Certificate Authority trusted by your Active Directory.
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Downloading a certificate with Firefox
1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. From within Internet Explorer, go to your Certificate Authority’s Web site.

3. Navigate to the page where you can generate or download a certificate 
(the steps to reach this page vary depending on the CA that you are 
using). 

4. When you are asked for the Cryptographic Service Provider (CSP), select 
ActivClient Cryptographic Service Provider from the list of providers.

5. Follow the CAs instructions to generate or download a certificate.

When your smart card is full (that is, if there is not enough space for the 
certificate that you are downloading), the ActivClient CSP overwrites the 
default certificate with the new certificate. In this case, a message is 
displayed that you are about to replace the existing credentials on the 
card. Select Yes to overwrite the default certificate. 

6. Verify that the key pair and associated certificate have been loaded on 
your smart card using the ActivClient User Console (optional).

Note: Once your certificate has been downloaded, Microsoft applications, such as 
Internet Explorer and Outlook display the certificate name and information. 
However, the private key associated with the certificate is not stored on the 
personal computer; therefore, you still need the smart card in order to use the 
certificate information.

Downloading a  cer t i f i ca te  wi th  F i re fox
You can use a PKI key pair (unique to you, generated directly on your smart 
card) and an associated digital certificate (proving your identity inside your 
organization) in order to use a variety of security services.

The following instructions also apply to Netscape and Mozilla.
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Managing user and CA certificates
To download  a  ce r t i f i ca te  w i th  F i re fox
Prerequisites

• A supported version of Firefox, Mozilla or Netscape is installed on your 
computer.

• Firefox, Mozilla and Netscape support has been installed during setup. 
The ActivClient PKCS#11 library has been registered to Firefox, Mozilla or 
Netscape. Refer to ActivClient Installation Guide for details.

• Your administrator provided you with a Web site URL to access your 
organization's Certificate Authority.

1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Use your Firefox browser to go to your Certificate Authority’s Web site.

3. Follow instructions for certificate request.

4. Enter your PIN when requested.

5. Verify that the key pair and associated certificate have been loaded on 
your smart card using the ActivClient User Console (optional).

Managing user  and CA cer t i f i ca tes
Once you have one or more certificates on your smart cart, ActivClient allows 
you to view, import, export and delete them. 

V iew ing  your  ce r t i f i ca te
You can view details of your certificates on your smart card using the 
ActivClient User Console.
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Managing user and CA certificates
To v iew a  cer t i f i ca te

1. Open ActivClient User Console.

2. Do one of the following:

– From the tasks pane under My Certificate Tasks, click View My 
Certificates.
An icon for each of your certificates is displayed.

– From the right pane, double-click the My Certificates icon.
An icon for each of your certificates is displayed.

3. Double-click the certificate that you want to view.

The Properties tab is displayed.

4. To view advanced properties, click the Advanced tab.

Note: In the Advanced tab, you can copy a value to another application, use the 
Copy command (CTRL + C) to move the selected text to the clipboard, and 
then use the Paste command (CTRL + V) to add the value.
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Managing user and CA certificates
Impor t ing  a  user  ce r t i f i ca te
If you are already using your personal PKI key pair and certificates, you can 
import them to your smart card as .pfx or .p12 file formats. This guarantees 
that your private credentials are portable and more secure inside your smart 
card.

To  impor t  a  user  cer t i f i ca te
Prerequisites

• ActivClient User Console is installed.

• A certificate is available as a PKCS#12 file on your workstation. To obtain 
this file, export your certificate by using for example, the Microsoft 
Internet Explorer Export function.

1. Open ActivClient User Console.

2. From the File menu, click Import.

3. In the File Browser dialog box, select the location and the file name for the 
certificate that you want to import, and click Open.

If the certificate is password-protected, the Password Request dialog box 
is displayed asking you to enter your password.

4. In the Password box, type the certificate password, and click OK.

5. When the confirmation message is displayed, click OK.

Impor t ing  a  CA cer t i f i ca te
You can store the Certificate Authority's root certificate on your smart card. 
This guarantees that the certificate chain is portable with your smart card, 
and that you can use your own certificates from any ActivClient workstation.

To  impor t  a  CA cer t i f i ca te
Prerequisites

• ActivClient User Console is installed.
ActivClient CAC User Guide  31



CHAPTER  4 :  MANAGING D IG ITAL  CERT I F ICATES
Managing user and CA certificates
• A certificate is available as a .cer or .crt file on your workstation. To 
obtain this file, export your CA certificate by using for example the 
Microsoft Internet Explorer Export function.

1. Open ActivClient User Console.

2. From the File menu, click Import.

3. In the File Browser dialog box, select the location and the file name for the 
certificate that you want to import, and click OK.

If the certificate is password protected, the Password Request dialog box 
is displayed asking you to enter your password.

4. In the Password box, type the certificate password, and click OK.

5. When a confirmation message is displayed, click OK.

Expor t ing  a  ce r t i f i ca te
Use the following procedure to send your certificate or CA certificate to 
someone by exporting it from your smart card into a file.

Note: For security reasons, you cannot export the private key located in your smart 
card. You can only export certificates from your smart card.

To  expor t  a  cer t i f i ca te
Prerequisites

• ActivClient User Console is installed on your workstation.

• A certificate is available on your smart card.

1. Open ActivClient User Console.

2. Do either one of the following:

– Select View My Certificates or View CA Certificates from the Tasks 
pane related section.
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Managing user and CA certificates
An icon representing each of your certificates or CA certificates is 
displayed.

– Double-click the My Certificates or CA Certificates icon from the right 
pane.
An icon representing each of your certificates or CA certificates is 
displayed.

3. Right-click the certificate you want to export.
A shortcut menu is displayed.

4. Select Export this certificate.
The Export Certificate dialog box is displayed.

5. Select the location and the file name for the exported certificate, and click 
Save.
A confirmation message is displayed.

6. Click OK.

De le t ing  a  ce r t i f i ca te
If a certificate is obsolete (expired or revoked), you can delete it from your 
smart card before you download a new certificate. Deleting a certificate 
applies both to user certificates (in My Certificates folder) and to CA 
certificates (in CA Certificates folder).

Important: Do not delete a certificate if you may need it to decrypt old documents or 
messages
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To de le te  a  cer t i f i ca te  f rom your  smar t  
card
Prerequisites

• ActivClient User Console is installed.

• A certificate is available on your smart card.

1. Open ActivClient User Console.

2. Do either one of the following:

– Select View My Certificates or View CA Certificates from the Tasks 
pane related section.
An icon representing each of your certificates is displayed.

-Or-

– Double-click the My Certificates or CA Certificates icon from the right 
pane.
An icon representing each of your certificate or CA certificates is 
displayed.

3. Do either one of the following:

– Right-click the certificate that you want to delete.
A shortcut menu is displayed.

– Select Delete this certificate from the certificate’s right-click menu.

-Or-

– Select one or several certificates in the right pane.
– Select Delete these Certificates from My Certificate Tasks section in 

the left pane.

-Or-

– Select one or several certificates in the right pane.
– Select the Delete red cross icon from the Standard toolbar.

A confirmation message is displayed asking you to confirm you want to 
delete your certificate. 
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4. Click Yes to confirm.

Note: You may not be able to delete some of your certificates depending of your 
smart card configuration.

Se lec t ing  cer t i f i ca tes  for  Windows PK I  
log in

If your smart card contains two or more certificates configured for Windows 
PKI logon (i.e. with specific attributes needed for Windows Logon), you can 
select which certificate to use for the Windows logon process using 
ActivClient User Console. With Windows Vista, there is no need to select any 
certificate to use with ActivClient User Console. Windows Vista lets you select 
which PKI login certificate to use at the time you log on.

To  se lec t  a  ce r t i f i ca te  fo r  W indows  PK I  
log in

Prerequisite

You have a Windows login compatible certificate available on your smart card. 
For more information, see "Downloading a certificate with Microsoft Internet 
Explorer" on page 27.

1. Open the ActivClient User Console.

2. Take one of the following actions to display your certificates:

– Select View My Certificates from the Tasks pane related section.
An icon representing each of your certificates is displayed.

– Double-click the My Certificates icon from the right pane.
An icon representing each of your certificates is displayed.

– Click on View My Certificates from the My Certificate Tasks section in 
the Tasks pane.
An icon for each of your certificate is displayed.

3. Select the certificate you want to use for Windows PKI login.
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4. Select Set this as default certificate from: 

– the certificate right-click menu
– the My Certificate Tasks section in the Tasks pane.

The certificate icon is updated with a green check mark .

Note: If you do not need to set a default logon certificate, then clear the check mark 
in front of Set this as default certificate.

To  unse lec t  a  log in  ce r t i f i ca te
Prerequisites

One of your certificates has been set as default.

When you do not need to set your login certificate as default, follow these 
steps:

1. Open ActivClient User Console.

2. Take one of the following actions to display your certificates:

– Click View My Certificates from the My Certificate Tasks section in the 
Tasks pane.
An icon for each of your certificate is displayed.

– Double-click the My Certificates icon located in the right pane.
An icon for each of your certificate is displayed.

– Click on View My Certificates from the My Certificate Tasks section in 
the Tasks pane.
An icon for each of your certificate is displayed.

3. Right-click the certificate set as default (easily recognized by a green 
check mark).

4. Select Set this as default certificate to invalidate the check mark.

The certificate icon is updated and the green check mark disappears .
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To temporar i l y  d i sab le  the  de fau l t  
ce r t i f i ca te  au tomat i c  se lec t ion

If your smart card contains several certificates, and if one of them is 
configured for the Windows PKI login, ActivClient automatically selects this 
certificate for the Windows PKI login operation (if several such certificates are 
present, ActivClient will automatically select the first one). However, you may 
want to temporarily disable this automatic selection.

Select Temporarily disable the default certificate automatic selection from the 
My Certificate Tasks section in the Tasks pane of the User Console. This 
implies that Windows PKI login and workstation PKI unlock are no longer 
possible except on Windows Vista. This selection will remain active until next 
time your remove your smart card.

To  enab le  th is  fea ture  aga in
Select Enable the default certificate automatic selection from the My 
Certificate Tasks section in the Tasks pane of the User Console.

Mak ing cer t i f i ca tes  ava i lab le  to  
Windows

Before you can use the certificates on your smart card, you must make them 
available to Windows-based applications (for example, Microsoft Internet 
Explorer, Outlook, and Windows login).

By default, ActivClient automatically registers all certificates on your smart 
card to make them automatically available to your desktop applications when 
you insert your smart card. No further action is required. 

Note: You need to make the certificates available to Windows manually when your 
administrator has configured ActivClient so that certificates are not 
automatically registered at card insertion. For information on configuration, 
refer to the ActivClient Customization and Deployment Guide.
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To make  cer t i f i ca tes  ava i l ab le  to  
W indows

This operation is needed only once, the first time you use a new smart card on 
a new workstation.

1. Open ActivClient User Console.

2. Go to Advanced from the Tools menu, and select Make Certificates 
Available to Windows.

-Or- 

Select Make available from your certificate right-click menu.

A message appears, informing you that the certificates have been made 
available for use with most desktop applications.
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Access and OTP

This section discusses the following topics:

• "Synchronizing smart cards" on page 39.

• "Configuring a remote access user name" on page 40.

Synchroniz ing smart  cards
If you are unable to authenticate using one-time passwords, contact your help 
desk to diagnose the problem. Your help desk may determine that your smart 
card is out of sync with the authentication server. In this case, perform the 
following steps in order to solve the problem.

To  synchron ize  your  smar t  ca rd
Prerequisites

• Your smart card is initialized to use one-time passwords.

• One-Time Password Services option has been installed during setup.

1. Open ActivClient User Console.

2. Take one of the following actions to select a server to authenticate to:

– From the Tasks pane, under One-Time Password Tasks, click View 
one-time password.
An icon for each authentication server is displayed (usually only one 
server is available, hence only one icon is displayed) in the right pane.

-Or-

– From the right pane, double-click the One-Time Password icon.
An icon for each authentication server is displayed (usually only one 
server is available, hence only one icon is displayed) in the right pane.

3. Take either one of the following action to start the synchronization:

– From the right-pane, right-click the One-Time Password icon and 
select Synchronize one-time password.
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-Or-
– From the Tasks pane, under One-Time Password Tasks, click 

Synchronize one-time password.
The Synchronize One-Time Password dialog box is displayed.

4. Provide the Clock and Counter values to your help desk.
Your help desk will synchronize or re-synchronize your device on the 
authentication server.

Conf igur ing a  remote  access  user  
name

If you want to use your smart card for remote access with one-time password, 
the smart card must also contain the user name used to logon to the remote 
service. Depending on your configuration, you may need to define or update 
the user name.
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To conf igure  your  remote  access  user  
name

Prerequisites

• Your smart card is initialized to use one-time passwords.

• The One-time Passwords Services option has been installed during setup.

1. Open ActivClient User Console.

2. Take one of the following actions:

– From the Tasks pane, under One-Time Password Tasks, click View 
one-time password.
An icon for each authentication server is displayed (usually only one 
server is available, hence only one icon is displayed) in the right pane.

-Or-

– From the right pane, double-click the One-Time Passwords icon.
An icon for each authentication server is displayed (usually only one 
server is available, hence only one icon is displayed) in the right pane.
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3. Select the server to which you want to authenticate.

4. Take one the following actions to configure your remote access user 
name:

– Right-click the server and select Configure one-time password.
The Configure One-Time Password dialog box is displayed.

-Or-

– From the Tasks pane, under One-Time Password Tasks, click on 
Configure one-time password.
The Configure One-Time Password dialog box is displayed.

5. Enter your name in the User Name box and click OK.
Your remote access user name is configured.
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Chapter 6: Using and 
managing ActivClient

This section discusses the following topics:

• "Viewing ActivClient system information" on page 43.

• "Troubleshooting ActivClient" on page 44.

• "Performing advanced diagnostics" on page 46.

• "Using the Forget state for all cards option" on page 49.

• "Using log system activity" on page 50.

• "Configuring ActivClient" on page 51.

• "Auto-Update service" on page 53

V iewing Act ivC l ient  sys tem 
informat ion

To help troubleshoot ActivClient issues, your help desk may ask you to 
provide system information about your ActivClient installation.

The About ActivClient window displays information such as:

• ActivClient edition and version number

• Build Number

• Copyright information

• Information about your system, such as Windows version and Web 
browser version

• Credits information (click on the Credits button)

To  v iew Ac t i vC l i en t  sys tem in format ion
• From ActivClient User Console:

Select About ActivClient fromthe Help menu.
The About ActivClient window is displayed.

-Or-

• From ActivClient Agent icon’s right-click menu:
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Select About from the ActivClient Agent icon’s right-click menu.
The About ActivClient window is displayed.

T roubleshoot ing  Act i vC l ient
The Troubleshooting Wizard:

• Helps resolve issues you may encounter while using a smart card with 
ActivClient.

• Analyzes your system.

• Diagnoses problems.

• Displays the results in the Diagnosis And Resolutions window.

• Provides instructions on how to correct problems!

To  use  the  Troub leshoot ing  Wizard
1. Click Next on the Welcome screen.

2. Read instructions to proceed.

3. Enter your PIN and click Next. 

If you omit entering your PIN, the Diagnosis and Resolutions report will not 
proceed with PIN related operations such as:

• Test encrypt and decrypt.
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• Digital signature.

• Web authentication.

4. If problems are detected, the Problems found page is displayed. Click 
Next.

5. Follow the instructions displayed in the Diagnosis and Resolutions page 
and click Finish.

To  access  the  Troub leshoot ing  Wizard
• From the ActivClient User Console Standard toolbar:

Select Run Troubleshoot Wizard.
The Troubleshooting wizard is displayed.

-Or-

• From the ActivClient User Console Help menu:

Select Troubleshoot.
The Troubleshooting wizard is displayed.

-Or-

• From the ActivClient User Console Help Tasks section:
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Select Troubleshoot a problem.
The Troubleshooting wizard is displayed.

-Or-

• From the Start menu:

Go to: Programs, ActivIdentity, ActivClient and select Troubleshooting.
The Troubleshooting wizard is displayed.

Per forming advanced d iagnost ics
The Advanced Diagnostics tool:

• Helps administrators perform a thorough examination of your 
environment. 

• Provides information synthesized in one single report which you can send 
to your help desk. 

The generated report is displayed in eight different views which you can 
access by clicking on corresponding tabs:

• Windows 

• Browsers 

• PC/SC 

• Readers 

• Smart Card 

• Configuration 

• Installation 

• Health Check 
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To use  the  Advanced  D iagnost i cs  
w izard

To generate  a  repor t

1. Make sure you inserted a smart card.

2. Click on the Diagnose button. 

A single report is generated and stored in a log file which you can send to 
your help desk.

To  d isp lay  your  repor t  
Click on one of the eight views you wish to display.

To  save  your  repor t  
Click on the Save button.
All your report's views are saved in one single log file.
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To copy  par t  o f  your  repor t  
Select a view and click Copy.
The content of the view you selected is copied and can now be pasted to the 
location of your choice.

To  emai l  your  repor t  
Click on the Email button.
Your report is saved in one single log file while your email programs opens. 
The log file is attached to the new mail message. You can finish writing your 
mail and send it to support.

To  pr in t  your  repor t  
Click on the Print button.
Your entire report including all eight views is automatically sent to your 
printer. 

Important: Printing your report may imply printing hundreds of pages at the same time. If 
you want to print part of your report, save it as a log file first and select only 
the part you wish to print!

Note: Your administrator may have pre-configured the email address to send the 
report to. This setting, along with other ActivClient configuration options, is 
available in the Advanced Configuration Manager. For more information, you 
can refer to the section about product customization in the ActivClient 
Customization and Deployment Guide (included in the ActivClient Resource 
Kit).

To  access  the  Advanced  D iagnost i cs  
w izard

To access the Advanced Diagnostics wizard, you can either take one of the 
following actions: 

• From the ActivClient Agent’s right-click menu:

Select Advanced Diagnostics.
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The Advanced Diagnostics wizard is displayed.

• From the ActivClient User Console Standard toolbar:

Select Advanced Diagnostics.
The Advanced Diagnostics wizard is displayed.

-Or-

• From the ActivClient User Console Help menu:

Select Diagnose.
The Advanced Diagnostics wizard is displayed.

-Or-

• From the Start menu:

Go to: Programs, ActivIdentity and select Advanced Diagnostics.
The Advanced Diagnostics wizard is displayed.

Us ing the  Forget  s ta te  for  a l l  cards  
opt ion

To optimize performance, ActivClient stores some smart card information on 
the workstation; this is limited to smart card configuration data (such as 
smart card profile) and excludes any user credentials such as user names, 
passwords, keys or digital certificates.
In most environments, ActivClient will refresh this information as needed 
when your smart card content is updated. In some cases, for trying to solve 
potential problems, your technical support may suggest to "tell" ActivClient to 
"forget" any smart card information it may have saved.

To  fo rget  s ta te  fo r  a l l  ca rds
1. Open ActivClient User Console.

2. Go to the Tools menu.

3. Select Advanced then, Forget state for all cards.

The information stored on your workstation about card configuration is reset.
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Using log  sys tem act iv i ty
Log files contains detailed information for every action performed by 
ActivClient. The information contained in these files may be useful for your 
technical support when trying to solve problems.

ActivClient allows you to configure log files without having necessarily 
administrator rights. You can configure log system activity from either:

• ActivClient User Console.

• Advanced Configuration Manager window (reserved for system 
administrators, refer to ActivClient Resource Kit for details on product 
customization).

Note: In order to guarantee privacy and security, no private key nor any confidential 
information are recorded in the ActivClient log files.

To  tu rn  on/of f  log  sys tem ac t i v i t y
• Turn off logging system activity in normal use cases.

• Turn on logging system activity only when required by your system 
administrator or help desk. 

Important: After log file creation, ActivIdentity recommends disabling log system activity!

To  ac t i va te  log  f i l es  f rom Act i vC l i en t  
User  Conso le

The following procedure is a quick way to configure log system activity.
You may want to access more options by going to the Logging section of the 
Advanced Configuration Manager.

1. Open ActivClient User Console.

1. Go to the Tools menu.

2. Select Advanced, Log File Options.
The Log File Options dialog box is displayed.
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3. Check the Record events in log files option.

4. Type a name in the Log File Name box.

5. Type a size for the log file in the Max Log File Size (in MB) box.

6. Click OK.

Conf igur ing Act ivC l ient
Only local administrators can configure ActivClient. Administrators can select 
specific security policies, such as “smart card removal behavior”. For example, 
when users remove their smart card from the smart card reader, the 
workstation behaves either way depending of pre-set configuration:

• Lock workstation

• Log off session

• No action

Configuring ActivClient is done in the Advanced Configuration Manager. For 
more specific information, you can refer to the section on product 
customization in the ActivClient Customization and Deployment Guide.
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For information on the settings and their values, read the description 
displayed at the bottom of the window each time you select an option.

To  access  the  Advanced  Conf igura t ion  
Manager

You can access the Advanced Configuration Manager by taking one of the 
following actions:

• From the ActivClient Agent’s right-click menu:

Select Advanced Configuration Manager.
The Advanced Configuration Manager window is displayed.

-Or-

• From the ActivClient User Console’s Tools menu:

Select Advanced then, Configuration.
The Advanced Configuration Manager window is displayed.

-Or-
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• From the Start Menu:

Go to Programs, ActivIdentity and select Advanced Configuration Manager.
The Advanced Configuration Manager window is displayed.

Auto-Update  serv ice
This feature is enabled only if the Auto-Update feature is installed. 
ActivClient can be configured so that software updates are automatically 
downloaded and installed on your workstation. 
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Chapter 7: Using Digital 
Certificates

This section discusses the following topics:

• "Logging on to Windows with a certificate" on page 54.

• "Locking your workstation on smart card removal" on page 55.

• "Using Windows Dial-Up/VPN for remote access" on page 56.

• "Using a non-Microsoft VPN for remote access" on page 57.

• "Accessing a secure Web site" on page 58.

• "Sending/Receiving signed and encrypted email messages with Microsoft 
Outlook" on page 60.

• "Sending/Receiving signed/encrypted mails with Netscape or 
Thunderbird" on page 64.

• "Encrypting/Decrypting files with EFS" on page 67.

Logging on to  Windows wi th  a  
cer t i f i ca te

You can use a smart card certificate to securely log on to Windows.

To  log  on  to  W indows  w i th  a  ce r t i f i ca te
Prerequisites

• Your smart card is configured with a certificate for Windows PKI login.

• Your workstation is configured for PKI login: the workstation must be 
attached to a domain, a root certificate must be available and a CRL server 
accessible.

• The Microsoft CAPI support option has been installed during setup.

1. Start your workstation.
The Welcome to Windows screen is displayed.

2. Insert your smart card (chip side up and chip first) into the smart card 
reader.
A Log On window relevant to your operating system is displayed.
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3. For Windows Vista, select a certificate among the smart card certificates 
compatible with Windows login.

4. Enter your PIN in the PIN box and click OK.
After a few moments, you are logged on and your desktop is displayed.

Lock ing your  workstat ion  on smart  
card  remova l

To increase the security of your computer and its contents, lock up your 
computer when you are away from it and keep your smart card safely in a 
separate place or on your person.

Note: Your administrator may have changed the Card Removal Behavior property. 
For more information on customization, refer to the ActivClient 
Customization and Deployment Guide.
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To lock  your  works ta t ion

Prerequ is i tes
• ActivClient is configured for “workstation locking on smart card removal” 

(default setting). 

• You used your smart card to log in to your workstation. 

Remove your smart card from the smart card reader.
Your workstation is now locked.

Us ing Windows Dia l-Up/VPN for  
remote  access

You can use your smart card-based digital certificate for secure remote 
access inside a Microsoft Windows environment.

To  use  Windows  D ia l-Up/VPN for  
remote  access

Prerequisites

• Your smart card contains a certificate configured for Windows PKI login. 

• You configured a Dial-Up or VPN connection on your workstation with the 
Windows Network Connection Wizard and selected the Use my smart card 
option.

1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. From the Start menu, go to Settings, and select Network Connections.
The Network Connections dialog box is displayed.

3. Choose your remote connection (Dial-Up or VPN).
The Connect Virtual Private Connection dialog box is displayed.
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4. Enter your PIN in the Smart card PIN box and click OK.
Once authentication is successful, the Dial-Up or VPN session is 
established.

Us ing a  non-Microsof t  VPN for  remote  
access

You can use your smart card-based digital certificate for authentication with 
several VPN products.

To  use  a  non-Mic rosof t  VPN for  remote  
access

Prerequisites

• You can access a VPN product supported by ActivClient. For the complete 
list, refer to ActivClient CAC Overview. 

• Your smart card contains a certificate configured for VPN login.

• You have configured your VPN to use an ActivClient-based digital 
certificate. Depending on the VPN products, you may need to select the 
cryptographic library (select the ActivClient Cryptographic Service 
Provider) and the certificate for the VPN authentication. For more 
information, refer to your VPN documentation.
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1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Start your VPN connection.

3. When prompted, type your smart card PIN, and click OK.
When you are authenticated, the VPN session is established.

Access ing a  secure  Web s i te  

Access  a  secure  Web s i te  w i th  In te rne t  
Exp lore r

You can use your smart card-based digital certificate to access a Web site 
protected by SSL v3 or TLS for strong user authentication.

To  access  a  secure  Web s i te  w i th  
In ternet  Exp lorer
Prerequisites

• Your smart card contains a certificate configured for authentication to this 
Web site.

• The Microsoft CAPI support option has been selected during setup.

1. Insert your smart card into the smart card reader.

2. Access the secure Web site or page using Microsoft Internet Explorer.
The Choose a digital certificate dialog box is displayed. 
ActivClient CAC User Guide  58



CHAPTER  7 :  US ING  D IG ITAL  CERT I F ICATES
Accessing a secure Web site
3. From the certificate list stored on your smart card, select the appropriate 
ActivClient certificate, and click OK.

4. Enter your PIN in the Smart card PIN box and click OK.
The browser sends your certificate and a digital signature to the Web 
server. The Web server verifies your signature and grants access to the 
secured site or page.

Access  a  secure  Web s i te  w i th  Ne tscape ,  
Moz i l l a  and  F i re fox

You can use your smart card-based digital certificate to access a Web site 
protected by SSL v3 for strong user authentication.

To  access  a  secure  Web s i te  w i th  
Netscape ,  Moz i l l a  or  F i re fox
Prerequisites

• Netscape, Mozilla or Firefox is installed on you computer.

• Your smart card contains a certificate configured for authentication to this 
Web site.

• The ActivClient PKCS#11 library has been registered to Firefox, Mozilla or 
Netscape. Refer to ActivClient Installation Guide for details.
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1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Start your browser from your desktop.

3. Access the secure Web site or page.

4. Enter your PIN.
Your browser sends your certificate and a digital signature to the Web 
server. The Web server verifies your signature and grants access to the 
secured site or page.

Sending/Rece iv ing s igned and 
encrypted emai l  messages  wi th  
Microsof t  Out look

Send ing/Rece iv ing  s igned  ema i l  
messages

A digital signature is a combination of your private key and a message. It 
authenticates you as the message sender and verifies the integrity of the 
message. With ActivClient, the digital signature is performed directly on your 
smart card.

To  send s igned emai l  messages
Prerequisites

• Microsoft Outlook is installed on your workstation.

• The Microsoft CAPI support option (from the Digital Certificates Services 
option) has been installed during setup.

• A certificate with email signature capabilities is available on your smart 
card.

1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Create the email message.
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3. Do one of the following: 

• Click on the Digitally Sign Message icon  from the Outlook toolbar.

-Or-

• If the icon does not appear on the toolbar:

– Click Options on the View menu (or the Options icon on the toolbar).
The Message Options dialog box is displayed.

– Click Security Settings.
The Security Properties dialog box is displayed.
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– Select the Add digital signature to this message check box and click 
OK.

– Close the Message Options dialog box.

4. Complete and send the email message.

To  rece ive  s igned emai l  messages
If you receive a digitally signed email message, you can use your email client 
to validate the sender's identity. Click the signed message that you want to 
read. If the sender is successfully authenticated, the message appears with a 
secure message icon.
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Send ing/Rece iv ing  encrypted  ema i l  
messages

Encrypting an email message guarantees that only the proper recipient can 
open and read the message and its attachments. Email encryption is based on 
the public key infrastructure.

Decrypting an encrypted email message is performed directly on your smart 
card for increased security.

To  send encrypted  emai l  messages
Prerequisites

• Microsoft Outlook is installed on your workstation.

• You have access to the certificate of the person to whom you want to send 
an encrypted email message. 

1. Create the email message.

2. Do one of the following:

• On the Outlook toolbar, click the Encrypt Message Contents and 
Attachments icon .

-Or-

• If the icon does not appear on the toolbar:

– Click Options on the View menu (or the Options icon on the toolbar).
The Message Options dialog box is displayed.

– Select Security Settings.
The Security Properties dialog box is displayed.

– Select the Encrypt message contents and attachments check box and 
click OK.

– Close the Messages Options dialog box.

3. Complete and send the email message.

To  rece ive  encrypted  emai l  messages
Prerequisites

• Microsoft Outlook is installed on your workstation.
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• A certificate with email encryption capabilities is available on your smart 
card.

• The Microsoft CAPI support option has been installed during setup.

1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Click the encrypted message you want to read.

3. Enter your PIN.
The email message and attachments are displayed along with the secure 
message icon informing you of the encryption status.

Sending/Rece iv ing s igned/encrypted 
mai ls  w i th  Netscape or  Thunderb i rd

Send ing/Rece iv ing  s igned  ema i l  
messages

A digital signature is a combination of your private key and a message. It 
authenticates you as the message sender and verifies the integrity of the 
message. With ActivClient, the digital signature is performed directly on your 
smart card.

To  send s igned emai l  messages
Prerequisites

• Netscape Messenger or Thunderbird is installed on you computer.

• A certificate with email signature capabilities is available on your smart 
card.

• The ActivClient PKCS#11library has been registered to Thunderbird or 
Netscape. Refer to ActivClient Installation Guide for details.

1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Start your email client.
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3. Open the Mail&Newsgroups window.

4. Click Compose.

5. Compose your mail and go to Security (on the top toolbar of your mail) 
and select Digitally Sign this message and encrypt.

6. Click Send.

7. Enter your PIN.

8. Verify the sent email has been signed.

To  rece ive  s igned emai l  messages

1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Start your email client.

3. Open the Mail&Newsgroups window.

4. Click on the signed message you want to read in your inbox. If the sender 
is successfully authenticated, the message appears with a secure message 
icon.

Send ing/Rece iv ing  encrypted  ema i l  
messages

Encrypting an email message guarantees that only the proper recipient can 
open and read the message and its attachments. Email encryption is based on 
the public key infrastructure.
Decrypting an encrypted email message is performed directly on your smart 
card for increased security.

To  send encrypted  emai l  messages
Prerequisites

• Netscape Messenger or Thunderbird is installed on you workstation.
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• The ActivClient PKCS#11library has been registered to Thunderbird or 
Netscape. Refer to ActivClient Installation Guide for details.

1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Start your email client.

3. Open the Mail&Newsgroups window.

4. Open a signed email (sent from computer).

5. Click Reply.

6. Compose your mail.

7. Go to Security (on top of the email toolbar) and select Encrypt this 
message.

8. Encrypt your mail.

9. Click Send.

10. Enter your PIN.

11. Look in your inbox for the sent email and verify if it is encrypted.

To  rece ive  encrypted  emai l  messages
Prerequisites

• Netscape Messenger or Thunderbird is installed on your workstation.

• A certificate with email signature capabilities is available on your smart 
card.

• The ActivClient PKCS#11library has been registered to Thunderbird or 
Netscape. Refer to ActivClient Installation Guide for details.

1. Insert your smart card (chip side up and chip first) into the smart card 
reader.

2. Start your email client.
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3. Open the Mail&Newsgroups window.

4. Select the encrypted email

5. Enter your PIN when prompted.

6. Read the encrypted mail in clear text.

Encrypt ing/Decrypt ing f i l es  w i th  EFS
Windows Vista allows Encryption File System (EFS) to use smart card 
certificates for files and folder encryption. Depending on your smart card 
content and your platform configuration you can seamlessly encrypt and 
decrypt files. 

Conf igur ing  your  works ta t ion  fo r  EFS
In order to encrypt and decrypt files on your workstation, depending on your 
platform configuration, you may need to configure EFS during your fist file 
encryption.

To  conf igure  your  worksta t ion  for  EFS  
w i th  your  smar t  card  encrypt ion  
cer t i f i ca te
Prerequisites

• Your Operating System is Windows Vista.

• Your platform is configured for EFS.

1. Start Microsoft Explorer.

2. Insert your smart card. 

3. Select the file or folder to encrypt.

4. Update your file or folder properties to enable encryption (via the 
Advanced button and the Encrypt contents to secure data option).
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5. When prompted to choose an existing encryption certificate or create a 
new one on your smart card, choose to select an existing encryption 
certificate.

6. Select your smart card EFS certificate in the certificate list.

7. Enter your smart card PIN and click OK.
The selected certificate will be used for all file encryption and decryption 
operations. The selected file or folder is encrypted and appears in green in 
Microsoft Explorer.

To  conf igure  your  worksta t ion  for  EFS  
and generate  a  smar t  card  encrypt ion  
cer t i f i ca te
Prerequisites

• Your Operating System is Windows Vista.

• Your platform is configured for EFS.

1. Start Microsoft Explorer.

2. Insert your smart card.

3. Select the file or folder to encrypt.

4. Update your file or folder properties to enable encryption (via the 
Advanced button and the Encrypt contents to secure data option).

5. When prompted to choose an existing encryption certificate or create a 
new one on your smart card, choose to create a new encryption certificate.

6. Choose to create either a smart card self-signed certificate or a certificate 
issued by your domain‘s certification authority.

7. Enter your smart card PIN and click OK.
The new certificate will be used for all file encryption and decryption 
operations.The selected file or folder is encrypted and appears in green in 
Microsoft Explorer.
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Encrypt ing/Decrypt ing  f i l es  o r  fo lders  
w i th  EFS

To encrypt  a  f i l e  or  fo lder  w i th  EFS
Prerequisites

• Your Operating System is Windows Vista.

• Your platform is configured for EFS.

• Your platform is configured to require the use of a smart card for EFS.

• Your smart card contains a certificate configured for EFS.

1. Start Microsoft Explorer.

2. Insert your smart card.

3. Select the file or the folder to encrypt.

4. Update your file or folder properties to enable encryption (via the 
Advanced button and the Encrypt contents to secure data option).

5. Enter your smart card PIN and click OK.
The file or the folder is then encrypted and appears in green in Microsoft 
Explorer.

To  decrypt  a  f i l e  or  fo lder  w i th  EFS
Prerequisites

• Your Operating System is Windows Vista.

• Your platform is configured for EFS.

• Your platform is configured to require the use of a smart card for EFS.

• Your smart card contains a certificate configured for EFS.

1. Start Microsoft Explorer.

2. Insert your smart card.
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3. Open the file or the folder to decrypt.
A window is displayed at the lower right corner of your desktop asking for 
your smart card PIN.

4. Click on the displayed link.

5. Enter your smart card PIN and click OK.
The file is opened in clear text.

Updat ing  EFS  Cer t i f i ca te  and  re-
encrypt ing  f i l es

If you have already encrypted some files with a certificate and if you want to 
update the encryption certificate (e.g. it expired), Windows allows you to re-
encrypt encrypted files with your new encryption certificate. 

To  re-encrypt  f i l es  and fo lders  w i th  a  
new EFS  cer t i f i ca te
Prerequisites

• Your Operating System is Windows Vista.

• Your platform is configured to allow EFS.

• Your platform is configured to require smart card for EFS.

• You have the smart card containing the EFS certificate currently 
configured for EFS on this platform.

• You have files encrypted with your current EFS certificate.
ActivClient CAC User Guide  70



CHAPTER  7 :  US ING  D IG ITAL  CERT I F ICATES
Encrypting/Decrypting files with EFS
1. Select User Accounts in Control Panel.

2. Select User Accounts.

3. Select Manage your file encryption certificates from the left pane.
The Manage your file encryption certificates wizard is displayed. 

4. When prompted to select an existing encryption certificate or create a new 
one on your smart card, choose to create a new certificate.

5. Choose to create either a smart card self-signed certificate or a certificate 
issued by your domain‘s certification authority.

6. Insert your smart card.

Note: The old EFS certificate and the new one will co-exist on the same card.

7. Click Next.

8. Back up your key (optional) and click Next.
A tree representing your file system is displayed.

9. Select the folders to re-encrypt. Make sure all folders containing your 
encrypted files are selected.

10. Enter your smart card PIN and click OK.
The wizard completes successfully.

To  re-encrypt  f i l es  and fo lders  w i th  an  
EFS  cer t i f i ca te  a l ready  on  your  smar t  
card
If you have already encrypted some files with a certificate and if you have 
updated the encryption certificate (e.g. it expired), Windows allows you to re-
encrypt your encrypted files with your new encryption certificate.

Prerequisites

• Your Operating System is Windows Vista.

• Your platform is configured to allow EFS.

• Your platform is configured to require the use of a smart card for EFS. 
ActivClient CAC User Guide  71



CHAPTER  7 :  US ING  D IG ITAL  CERT I F ICATES
Encrypting/Decrypting files with EFS
• You have a smart card containing an EFS certificate currently configured 
for EFS on this platform.

• You have a smart card containing a new certificate. 

• You have files encrypted with your current EFS certificate.

1. Select User Accounts in Control Panel.

2. Select User Accounts.

3. Select Manage your file encryption certificates from the left pane.

The Manage your file encryption certificates wizard is displayed.

4. When prompted to select an existing encryption certificate or create a new 
one on your smart card, choose to select an existing encryption 
certificate.

5. Select your new smart card EFS certificate from the certificate list.
A tree representing your file system is displayed.

6. Select the folders to re-encrypt. Make sure all the folders containing your 
encrypted files are selected.

7. Enter your PIN whenever you are prompted to do it.
The wizard completes successfully.

Recover ing  encrypted  f i l es
When you loose or damage your smart card, you need to recover your 
encrypted files content.

To  recover  encrypted  f i l es
Prerequisites

• Your Operating System is Windows Vista.

• Your platform is configured to allow EFS.

• Your platform is configured to require smart card for EFS.

• You have backed up your EFS certificate in a certificate file in a secure 
location.
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• You have a new smart card.

• You have files encrypted with your lost or damaged EFS certificate smart 
card. 

1. Import the backup EFS certificate in your new smart card with ActivClient 
User Console.

2. In Microsoft Explorer, select any of the encrypted file you need to recover.

3. When prompted, insert your new EFS certificate smart card.

4. Enter your smart card PIN and click OK.
You can access your file in clear text.

Note: Depending on your configuration, a recovery agent may be configured to help 
you recover your data. For more information on files and folders recovery, 
refer to Microsoft Windows Help on your Windows Vista workstation.
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Access/OTP

This section discusses the following topics:

• "Getting a one-time password automatically" on page 74

• "Getting a one-time password manually" on page 75

Get t ing  a  one-t ime password 
automat ica l l y

ActivClient provides an automatic way to log on to some remote access 
applications using one-time passwords.
The Get One-Time Password (OTP) option:

• Generates the OTP in a synchronous mode

• Displays the OTP in a notification window (a tool tip is displayed on the 
workstation’s taskbar)

• Automatically copies the OTP to the clipboard so it is ready to be pasted 
into any application.

To  ge t  a  one-t ime  password  
automat i ca l l y

Prerequisites

• ActivClient Agent has been installed.

• One-Time Password Services option has been installed during setup.

• Your smart card is initialized to use one-time passwords.

1. Right click on ActivClient Agent.

2. Select Get One-Time Password.
The ActivClient notification window is displayed, showing the one-time 
password generated on your smart card.

3. Place your cursor in the password box of the application you want to 
authenticate to. 
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4. Select Paste (or press Ctrl + V). 
The one-time password generated by ActivClient is pasted into the 
application of your choice.

Get t ing  a  one-t ime password 
manual ly

ActivClient also provides a manual way to log on to some remote access 
applications by generating a one-time password using the ActivClient User 
Console. You can then use this password with any application (whether 
running on your workstation or not).

To  ge t  a  One-t ime  password  manua l l y
Prerequisites

• ActivClient User Console is open.

• One-Time Password Services option has been installed during setup.

• Your smart card has been initialized to use one-time passwords.

1. Display the Generate One-Time Password dialog box by taking one of the 
following actions:

• From the ActivClient User Console tasks pane:

Select Generate One-Time Passwords.
The Generate One-Time Password window is displayed.

-Or-

• From the ActivClient User Console right pane:

Double-click the server’s icon.
The Generate One-Time Password window is displayed.

2. Take one of the following actions depending of your administrator’s 
recommendations:

• If your administrator recommends to authenticate in Automatic mode, 
click Generate.
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A one-time password is displayed which you can type or copy/paste into 
any authentication window.

-Or-

• If your administrator recommends to authenticate in a Challenge/
Response mode, click Manual (Challenge/Response) from the Type drop-
down list. A Challenge box is displayed in the Generate One-Time 
Password window.

3. Locate the challenge on the application you are authenticating to. (For 
challenge/response applications, the challenge is displayed in the dialog 
box used when logging in).

4. Type the challenge in the Challenge box.

5. Click Generate.
Your newly generated one-time password is displayed.

6. Type (or copy and paste) it into any authentication window.
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information

This section discusses the way you can display your smart card personal 
information.

About  Persona l  In format ion
US Department of Defense CAC smart cards and US Government Personal 
Identity Verification PIV smart cards allow to access personal information for 
each smart card holder.
Personal information display may vary according to your type of card and 
profile. It includes: 

• Cardholder Identification and general information

• Benefits

• Employment information

• Cardholder’s facial image

Important: The View my personal info feature is a read-only feature!

To  access  “My  Persona l  In fo ”  on  CAC 
and  P IV  ca rds

Take one of the following actions:

• From the User Console left pane:
Click on View my personal info under My Personal Info Task.
The Personal Information dialog box is displayed on the right pane

• From the User Console right pane:
Double-click My Personal Info icon.

-Or-

Select Open from it’s right-click menu.
The Personal Information dialog box is displayed on the right pane.
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Note: For PIV smart cards, the User Console displays the digital signature’s validity 
for:

– CHUID (Card Holder Identification)
– Fingerprints
– Facial Image
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ActivClient with Terminal 
Services

This section discusses the following topics:

• "Logging on to a Citrix session" on page 79.

• "Using a smart card inside a Citrix session" on page 82.

• "Logging on to a Remote Desktop session" on page 83.

• "Using a smart card in a Remote Desktop session" on page 84.

• "Locking a Remote Desktop session" on page 85.

Logging on to  a  C i t r ix  sess ion
You can use Citrix products to run an application on a Citrix server and 
interact with the end user on a different terminal (Windows or another). 
ActivClient provides smart card-based authentication to Citrix for increased 
security.

Note: It is not necessary to install ActivClient on the Citrix client.

To  log  on  us ing  a  C i t r ix  p roduct
Prerequisites

• ActivClient is installed on the Citrix Presentation Server. For more 
information on supported versions of Citrix Presentation Server, refer to 
ActivClient CAC Overview.

• Your workstation is configured with Citrix client (Program Neighborhood, 
Program Neighborhood Agent, or Web interface).

• You have a smart card and a smart card reader up and running and 
connected to your workstation. 

How you log on to a Citrix session depends on your configuration. Here are 
the four cases you may encounter:

• You log on to your workstation with a smart card and digital certificate 
and your Citrix authentication mode is “Smart Card with Pass-through” 
ActivClient CAC User Guide 79



CHAPTER  10 :  US ING  ACT IVCL I ENT  W ITH  TERMINAL  SERV ICES
Logging on to a Citrix session
then, you are logged in automatically as soon as you start a Citrix session. 
See Chapter 7, "Logging on to Windows with a certificate" on page 54.

• You log on to your workstation with a user name and password (standard 
Windows authentication) and your Citrix authentication mode is “Local 
User with Pass-through” then, you are logged in automatically as soon as 
you start a Citrix session. See Chapter 7, "Logging on to Windows with a 
certificate" on page 54.

• You log on to your workstation with a thin terminal (Windows XP 
Embedded) without ActivClient on the thin terminal and your Citrix 
authentication mode is “Local User with Pass-through” then, you are 
logged in automatically as soon as you start a Citrix session.

• You log on to your workstation with a thin terminal (Windows CE) without 
ActivClient on the thin terminal and no local authentication and your Citrix 
authentication mode is “Local User Pass-through” then, you are prompted 
to authenticate with your smart card and PIN code.

To  open  a  C i t r ix  sess ion-examples
Three Citrix clients can be used to log on to a Citrix session:

• Citrix ICA Client Program Neighborhood 

• Citrix ICA Client Program Neighborhood Agent 

• Citrix Web Interface 

Here are examples of Citrix login session for “Smart Card with Pass-through” 
authentication mode with each of the Citrix clients.

To  log  on  to  a  C i t r ix  sess ion  in  a  “Smart  
Card  w i th  Pass-t rough”  authent ica t ion  
mode us ing  C i t r ix  ICA C l ient  P rogram 
Ne ighborhood
Prerequisites

• Microsoft CAPI support option has been installed during setup.

• You have a smart card and a certificate with PKI login capabilities. 

• Citrix ICA Client Program Neighborhood is installed. 

• A custom ICA connection is configured for your Citrix Server. 

• The Citrix authentication mode is “Smart Card with Pass-through”. 
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1. Log on to Windows using your smart card.

2. Double-click on Citrix Program Neighborhood icon.

The Citrix Program Neighborhood opens.

3. Double-click on your custom ICA connection in the Citrix Program 
Neighborhood window.
You are automatically logged on to the Citrix remote session.

To  log  on  to  a  C i t r ix  sess ion  in  “Smar t  
Card  w i th  Pass-t rough”  authent ica t ion  
mode us ing  C i t r ix  ICA C l ient  P rogram 
Ne ighborhood Agent
Prerequisites

• Microsoft CAPI support has been installed during setup.

• You have a smart card and a certificate with PKI login capabilities.

• Citrix ICA Client Program Neighborhood Agent is installed.

• The Citrix authentication mode is “Smart Card with Pass-through”.

• Your Web Interface Server URL is configured in Citrix ICA Client Program 
Neighborhood Agent.

1. Log on to Windows using your smart card.

2. Right-click on the Citrix Program Neighborhood Agent icon located on the 
workstation’s taskbar and select your Citrix server desktop.
You are automatically logged on to the Citrix remote session.

To  log  on  to  a  C i t r ix  sess ion  in  “Smar t  
Card  w i th  Pass-t rough”  authent ica t ion  
mode us ing  C i t r ix  Web In ter face
Prerequisites

• Microsoft CAPI support has been installed during setup.

• You have a smart card and a certificate with PKI login capabilities.
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• Citrix Web interface Client is installed. 

• Citrix authentication mode is “Smart Card with Pass-through”. 

• Your Web Interface Server URL is configured in Citrix ICA Client Program 
Neighborhood Agent. 

1. Log on to Windows using your smart card.

2. Open your browser.

3. Enter your Web Interface Server URL.
You are automatically authenticated and you access your Citrix Web 
Interface web page 

4. Double-click on your Citrix server desktop icon in your Citrix Web 
Interface web page.
The Windows login interface of your Citrix server desktop appears within 
your browser window.

5. Enter your PIN code.
You are automatically logged on to the Citrix remote session within your 
browser window. 

Note: You can find more information on Citrix clients configuration in the Citrix 
documentation available on Citrix website.

Us ing a  smart  card  ins ide  a  C i t r ix  
sess ion

You can use Citrix Presentation Server to run an application on a Citrix server 
and interact with the end user on a different terminal (Windows or another).
ActivClient provides smart card-based services for applications running in the 
Citrix session.

Note: It is not necessary to install ActivClient on the Citrix client workstation.
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To use  your  smar t  ca rd  ins ide  a  C i t r ix  
sess ion

Prerequisites

• ActivClient is installed on the Citrix Presentation Server. For more 
information on supported versions of Citrix Presentation Server, refer to 
ActivClient CACOverview.

• Your workstation is configured with Citrix client (Program Neighborhood, 
Program Neighborhood Agent, or Web interface).

• You have a smart card and a smart card reader up and running and 
connected to your workstation. 

• You are logged on to a Citrix session.

1. Start the application you are using with your smart card, for example, 
Microsoft Outlook.

2. Use the application as usual, and access smart card-based services, for 
example, prepare to send a signed email message.

3. When you are prompted for the PIN, type your smart card PIN, and click 
OK.

The application running on the Citrix server communicates with your 
smart card that is connected locally to your computer. 

Note: Smart card management operations such as certificate download operations 
are not available within the Citrix session.

Logging on to  a  Remote  Desktop 
sess ion

Microsoft Remote Desktop allows you:

• To remotely control your computer from another office, home, or while 
traveling in order to use the data, applications, and network resources 
that are on your office computer without being in your office. 

• To connect to a Windows Server with Windows Terminal Services enabled, 
to access applications not available on your local workstation.
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ActivClient provides smart card-based authentication to the Remote Desktop 
for increased security.

Note: It is not necessary to install ActivClient on the client workstation. For 
information about supported environments, refer to ActivClient CACOverview.

To  log  on  to  a  Remote  Desktop  sess ion
Prerequisites 

• The remote computer you intend to access using Remote Desktop 
Connection can either be Window Vista or Windows Server 2003 with 
Windows Terminal Services, all of them having ActivClient installed.

• Your workstation is either Windows XP Professional or, Windows Vista with 
Remote Desktop Connection v5 or v6 installed.

• You have a smart card and a smart card reader up and running connected 
to your workstation.

1. Log on to your workstation.

2. Start the Remote Desktop Connection.

3. Select the server or workstation you want to access and click Connect.

4. Make sure your smart card is inserted.

5. Enter your PIN to start the session.

Us ing a  smart  card  in  a  Remote  
Desktop sess ion

You can use Microsoft Remote Desktop to run an application on a PC 
(workstation or server) and interact with the end user on a different 
workstation. ActivClient provides smart card-based services for applications 
running in the Remote Desktop session.

Note: It is not necessary to install ActivClient on the client workstation.
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To use  your  smar t  ca rd  in  a  Remote  
Desktop  sess ion

Prerequisites

• The remote computer you intend to access using Remote Desktop 
Connection can either be Windows XP Professional, Window Vista or 
Windows Server 2003 with Windows Terminal Services, all of them having 
ActivClient installed.

• Your workstation is either Windows XP Professional or, Windows Vista with 
Remote Desktop Connection v5 or v6 installed.

• You have a smart card and a smart card reader up and running connected 
to your workstation.

• You are logged on to a Remote Desktop session.

1. Start the application that is using your smart card, for example, Microsoft 
Outlook.

2. Use the application as usual, and access smart card-based services, for 
example, prepare to send a signed email message.

3. When you are prompted for the PIN, type your smart card PIN, and click 
OK.

The application running on the Remote Desktop (remote computer) 
communicates with your smart card that is connected locally to your 
computer. After a few moments, the operation is completed, for example, 
the signed email is sent.

Note: Smart card management operations such as certificate download operations 
are not available within a Remote Desktop session.

Lock ing a  Remote  Desktop sess ion
Microsoft Remote Desktop allows you to:

• Remotely control your computer from another office, home, or while 
traveling in order to use the data, applications, and network resources 
that are on your office computer without being in your office.

• Connect to a Windows Server with Windows Terminal Services enabled, to 
access applications not available on your local workstation.
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To lock  a  Remote  Desktop sess ion
Prerequisites

• The remote computer you intend to access using Remote Desktop 
Connection can either be Windows XP Professional, Window Vista or 
Windows Server 2003 with Windows Terminal Services, all of them having 
ActivClient installed.

• Your workstation is either Windows XP Professional or, Windows Vista with 
Remote Desktop Connection v5 or v6 installed.

• You have a smart card and a smart card reader up and running connected 
to your workstation.

• You are logged on to a Remote Desktop session with your smart card.

Remove your smart card from the smart card reader. 

The session remains open on the remote computer. You will find the session 
in the same state the next time you log on, that is, the same applications will 
remain open in the state they were in when you locked the session. 

The default configuration for ActivClient (running on the remote computer) is 
to lock on smart card removal. If your administrator changes this 
configuration (for example, to log off on smart card removal), the behavior 
may differ (for example, the Remote Desktop session may close).
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Terms and Acronyms
This chapter presents terms and acronyms used in this publication.

Terminology

Terms Definitions

Certificate Authority (CA) The CA issues and manages security credentials and public keys 
for message encryption in a networked environment. As part of a 
Public Key Infrastructure (PKI), a CA checks with a registration 
authority (RA) to verify information provided by the requestor of 
a digital certificate. If the RA verifies the requestor's information, 
the CA issues a certificate.

ActivID Card Management 
System (CMS)

Formally known as ActivCard Identity Management System 
(AIMS), CMS is a Web-based, smart card, credential and 
application lifecycle management system.
CMS augments and works in concert with an enterprise's primary 
identity management infrastructure components, including 
popular directory, database, and PKI components.

Cryptographic Service 
Provider

An independent software module that performs cryptography 
algorithms for authentication, encoding, and encryption.

Federal Information 
Processing Standard (FIPS)

FIPS 140-2 is the standard for crypto-module security. FIPS 140-
2 level 3 adds additional requirements to FIPS 140-2 level 2. 
These requirements concern physical security and a trusted path 
for entering a Cryptographic Service Provider, such as a PIN. FIPS 
140-2 level 3 uses local ports and the key pad to enforce such 
security.

GlobalPlatform Replaces OpenPlatform (OP).

My Digital ID Card This CMS component allows end users to access the self-service 
CMS functions, which includes card and credential management.

One-Time Password A one-time password is a password used only once to 
authenticate to remote applications. One-Time Passwords are 
only present on smart cards issued with SKI credentials.

PIN Personal Identification Number. Is used to authenticate to your 
smart card in order to perform actions such as Windows PKI 
login, remote access and email signature.

Public Key Infrastructure 
(PKI)

PKI describes the laws, policies, standards, and software that 
regulate or manipulate certificates and public and private keys.
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TERMINOLOGY  AND ACRONYMS
Acronyms
Acronyms

Registration Authority 
(RA) 

RA is an authority in a network that verifies user requests for a 
digital certificate and instructs the CA to issue it. An RA is part of 
a PKI, a networked system that enables companies and users to 
exchange information safely and securely.

SKI SKI (Symmetric Key Infrastructure) keys are used to perform 
strong authentication on remote applications. SKI keys encrypt 
passwords in: 

• Synchronous mode (generates 1 password without any 
challenge. The server uses the same method to create a 
password than the smart card) 

• Asynchronous: encrypts a challenge

Standalone smart card Smart card with uploaded applets issued by the manufacturer.

Acronyms Definitions

CA Certificate Authority.

CAC Common Access Card (for the United States Department of 
Defense).

CSP Cryptographic Service Provider.

FIPS Federal Information Processing Standard.

GP GlobalPlatform. Replaces OpenPlatform (OP).

OTP One-Time Password.

PKI Public Key Infrastructure.

PIV Personal Identity Verification Card issued by the United States 
government to federal employees and contractors.

RA Registration Authority.

SKI Symmetric Key Infrastructure.
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